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INTRODUCTION

These templates have been created in response to
requests and feedback from our regional members.
They are designed to make the local production

of IMechE branded materials as easy as possible
while maintaining a consistent application of our
brand across all our regions.

Specific requirements will vary by region but
there should be enough flexibility within the
templates to meet most needs. The guidelines
give clear instructions on how to make the most
of the templates and also provide a framework to
ensure that what is finally produced remains true
to our branding standards. Consistent application
of our brand is essential as we build a strong
brand identity and we all have our part to play in
ensuring that consistency.

Some of the templates for posters and flyers
include templates that are co-branded with our
fellow institutions like ICE and IET. This is
particularly appropriate for some of our
international regions where a lot of events are
organised with ICE and IET. These templates also
include provision for the inclusion of sponsor logos.

Some of the templates, like the A6 programme of
events, have had a high level of functionality built
into them and need to be used with careful
reference to the guidelines.

Throughout our regions a lot of great work is being
done by our volunteer members and it is hoped
that these templates will support and facilitate
that work while ensuring that we build a strong
international brand.



BUSINESS CARD

The business card artwork is designed
for overprinting onto double-sided Avery
business card template — C32015-25.

The front of the card features personal and
contact details and the reverse of the card
features the Institution's vision statement.

All elements should be set in sentence case,
with the exception of the post code.

Telephone/fax numbers should be
formatted in the following style:

+44 (0)20 1234 5678 * +44 (0)845 123 4567

There is a three line provision for the
address element. Commas may be used
to separate longer addresses.

The IMechE URL - www.imeche.org appears
on the fourth line below the address.
This should be included on all cards.
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John Doe
Regional Manager

T +44 (0)20 1234 5678
F +44 (0)20 1234 5678
M +44 (0)1234 567 890
E johndoe@imeche.org

1 Birdcage Walk
Westminster
London SW1H 91]
www.imeche.org
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LAPEL BADGE

The lapel badge artwork is designed for
overprinting onto single-sided Avery
business card template — C32011-25.

The badge features name and job title
plus the Institution’s vision statement.

Both elements should be set in sentence case.

If a blank badge is required — you may
delete the name and job title elements.
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FAX TEMPLATE

The fax template features two distinct areas
of information — the contact information
found at the top of the fax cover page and
the main body of the fax which falls below
this and on subsequent pages as required.

All elements should be set in sentence case.

Telephone/fax numbers should be
formatted in the following style:

+44 (0)20 1234 5678 * +44 (0)845 123 4567
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To: John Doe Recipient Fax: +44 (0)123 45678
From: Jane Doe Sender Fax: +44 (0)123 45678
Date: 05.03.09 Sender Tel: +44 (0)123 45678
Pages: 5

Subject: Cooling the Planet

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Sed quis
nunc. Cum sociis natoque penatibus et magnis dis parturient montes,
nascetur ridiculus mus. Duis justo. Cras quis massa. Etiam lacus.
Nunc molestie, mi ac fermentum semper, dolor dui lobortis metus, ut
semper tortor arcu at erat. Nam lobortis nisl ut velit. Sed consectetur,
risus et dignissim bibendum, sapien dolor auctor justo, vitae gravida
lectus nunc sed ante. Nullam eget ligula eu libero scelerisque congue.
Nam non lectus a leo hendrerit fermentum. Vivamus felis sem,
pulvinar eu, rhoncus nec, vulputate at, massa.

Vestibulum sem arcu, pulvinar quis, adipiscing in, viverra in, risus.
Donec fringilla, neque quis semper faucibus, metus diam congue
libero, vel mattis sapien erat quis augue. Curabitur vestibulum, leo
eu commodo pretium, nibh mi eleifend dui, quis mollis magna urna
sit amet elit. Ut et felis. Nulla facilisi. Etiam neque nisi, porttitor non,
eleifend nec, molestie posuere, erat. Proin ac tortor. Aliquam erat
volutpat. Class aptent taciti sociosqu ad litora torquent per conubia
nostra, per inceptos himenaeos. Suspendisse nisi ligula, laoreet sit
amet, tristique id, fringilla quis, nunc. Pellentesque eu enim. Nullam
lorem nisl, placerat eu, mattis eget, molestie a, urna. Nunc quis

leo sed ante fermentum bibendum. Cras nisi metus, elementum in,
fermentum vel, elementum quis, pede. Vestibulum ornare ligula sed
sapien. Suspendisse sit amet magna. Cras laoreet, ligula non rutrum
semper, lorem urna mollis sem, eget venenatis odio lectus eget
sapien.

Cras at tortor sit amet arcu fringilla iaculis. Aenean libero. Etiam
eget diam ac quam venenatis condimentum. Donec congue metus
nec neque. Sed non magna. In et lacus. Integer mi nisi, facilisis quis,
adipiscing id, convallis a, metus. Nunc tortor. Integer a metus. Proin
quam est, aliquet et, accumsan sit amet, molestie id, libero. Etiam.
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A4 POSTER

The A4 poster template features 6
distinct areas of information:

1.

Region/group information. Please delete
this information if this is not relevant to
your communication. Formatting for this
element can be found in the Formatting
palette. Region/group information
should be set in sentence case.

Headline. This is set in Verdana Bold with
the size being adjusted according to the
length of the headline. As the point size of
the headline type is adjusted — likewise the
leading should be adjusted accordingly. Please
see the accompanying examples for guidance.
A rough guide is to make the leading 2pt
below the point size — for example 20pt type
with 18pt leading. The headline should be set
in a combination of IMechE Dark Red/Light
Red with the Dark Red preceding the Light
Red. Headlines should be set in title case.

Main body copy. This is for a concise synopsis
of the event. Formatting for this element can
be found in the Formatting palette. The main
body copy should be set in sentence case.

Date/time/location/contact details. This
area is for the date and time of the event,
event location and any further contact
information. Formatting for this element
can be found in the Formatting palette. All
information should be set in sentence case.

5. Image area. Each template has the provision
for an image measuring 124 x 194mm.

To insert an image

i. Double click the prompt within the
placeholder, for example: “Dbl click to
insert image. Image size: 124 x 194 mm’

ii. Locate the image

iii. Click ‘Insert’

To resize the image

i. After inserting the image, single click it, then
drag from the bottom right anchor until the

image is the desired size within the placeholder.

To replace the image

i. Click ‘Insert’

ii. Click ‘Picture’

iii. Click ‘From File' and navigate to the file
location, insert the new image and resize.

There are six different versions of the A4 poster
template — an IMechE branded template, an
IMechE/ICE branded template, an IMechE/
IET branded template and IMechE/ICE/IET
branded template. There is also an IMechE

and IMechE/ICE/IET template with the
provision for the inclusion of up to 6 different
sponsor logos. Please select the template
which is most appropriate to your event.

6. Logo area. This appears on the relevant
IMechE and IMeche/ICE/IET templates only.
Each logo area has the provision for up to
six different partner/sponsor logos each
measuring up to 13.5 x 26mm. Logos can
be inserted/resized/replaced in the same
way as images in section 5 above.

To resize all the logos simultaneously

Once all your artwork is inserted into

the logo placeholders, click each image
independently, hold down the Control
‘Ctrl’ key and ‘'Y’ key simultaneously,

each of the images will resize — this avoids
having to repeat the ‘resize image’ steps.

For more on imagery please see page 24.
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Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse

ut leo sit amet erat tincidunt posuere. Duis
luctus lacus in enim auctor euismod. Etiam
rutrum libero sed neque. Morbi gravida ante
non est. Cras sit amet erat. Sed blandit, augue
sed luctus volutpat, purus justo volutpat

velit, egestas adipiscing leo leo at diam. In
lacinia imperdiet neque. In hac habitasse
platea dictumst. Sed semper vehi cula elit.
Suspendisse potenti. Aenean inter dum. Mauris
vel magna a nisl ultricies cursus. Ves tibulum
ante ipsum primis in faucibus orci luctus et

17 September at 7.30pm

Institution of Mechanical Engineers
1 Birdcage Walk, Westminster
London SW1H 9]1]

For more information please contact:

John Doe

+44 (0)20 1234 5678
johndoe@imeche.org
imeche.org/events/automobile/fs
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Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse

ut leo sit amet erat tincidunt posuere. Duis
luctus lacus in enim auctor euismod. Etiam
rutrum libero sed neque. Morbi gravida ante
non est. Cras sit amet erat. Sed blandit, augue
sed luctus volutpat, purus justo volutpat

velit, egestas adipiscing leo leo at diam. In
lacinia imperdiet neque. In hac habitasse
platea dictumst. Sed semper vehi cula elit.
Suspendisse potenti. Aenean inter dum. Mauris
vel magna a nisl ultricies cursus. Ves tibulum
ante ipsum primis in faucibus orci luctus et

17 September at 7.30pm

Institution of Mechanical Engineers
1 Birdcage Walk, Westminster
London SW1H 9]]

For more information please contact:

John Doe

+44 (0)20 1234 5678
johndoe@imeche.org
imeche.org/events/automobile/fs



Automobile Division
Essex Centre

FORMULA
STUDENT
IN POLE
POSITION.

&)

ALY
ITA
-

7

i

Autodesk  WiNsTruments

Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse

ut leo sit amet erat tincidunt posuere. Duis
luctus lacus in enim auctor euismod. Etiam
rutrum libero sed neque. Morbi gravida ante
non est. Cras sit amet erat. Sed blandit, augue
sed luctus volutpat, purus justo volutpat

velit, egestas adipiscing leo leo at diam. In
lacinia imperdiet neque. In hac habitasse
platea dictumst. Sed semper vehi cula elit.
Suspendisse potenti. Aenean inter dum. Mauris
vel magna a nisl ultricies cursus. Ves tibulum
ante ipsum primis in faucibus orci luctus et

17 September at 7.30pm

Institution of Mechanical Engineers
1 Birdcage Walk, Westminster
London SW1H 9]]

For more information please contact:

John Doe

+44 (0)20 1234 5678
johndoe@imeche.org
imeche.org/events/automobile/fs



A4 FLYER

The A4 flyer template is similar to the

A4 poster template, but is double-sided
allowing for the inclusion of more extensive
information regarding your event.

It features 11 distinct areas of information:

1.

Region/group information. Please delete this
information if this is not relevant to your
communication. Formatting for this element
can be found in the Formatting palette.
Region/group information should

be set in sentence case.

Headline. This is set in Verdana Bold with
the size being adjusted according to the
length of the headline. As the point size of
the headline type is adjusted — likewise the
leading should be adjusted accordingly. Please
see the accompanying examples for guidance.
A rough guide is to make the leading 2pt
below the point size — for example 20pt type
with 18pt leading. The headline should be set
in a combination of IMechE Dark Red/Light
Red with the Dark Red preceding the Light
Red. Headlines should be set in title case.

Speakers/brief synopsis. This area is for

the inclusion of the primary speaker/s plus
a brief synopsis of the event. Formatting

for this element can be found in the
Formatting palette. The speaker/s and brief
synopsis should be set in sentence case.

Date/time/location. This area is for the
date and time of the event plus the event
location. Formatting for this element can
be found in the Formatting palette. All
information should be set in sentence case.

Image area. Each template has the provision
for an image measuring 124 x 194mm.

To insert an image

i.

ii.

iii.

Double click the prompt within the
placeholder, for example: “Dbl click to
insert image. Image size: 124 x 194 mm’
Locate the image

Click ‘Insert’

To resize the image

i.

After inserting the image, single click it, then
drag from the bottom right anchor until the
image is the desired size within the placeholder.

To replace the image

i. Click ‘Insert’

ii. Click ‘Picture’

iii. Click ‘From File' and navigate to the file
location, insert the new image and resize

6. Headline. Please repeat the headline
from the front of the flyer here.

7. Sub-title — if required. Formatting for this
element can be found in the Formatting palette.
The sub-title should be set in sentence case.

8. Main body copy. This is for detailed
information regarding the event.
Formatting for this element can be found
in the Formatting palette. The Main body
copy should be set in sentence case.

9. Date/Time/Location/Contact details. This
area is for the date and time of the event,
event location and any further contact
information. Formatting for this element
can be found in the Formatting palette. All
information should be set in sentence case.

There are two different versions of the A4
flyer template — an IMechE branded template,
an IMechE/ICE/IET branded template

and a IMechE/ICE/IET template with the
provision for the inclusion of up to 6 different
sponsor logos. Please select the template
which is most appropriate to your event.

10. Logo area. This appears on the relevant
IMechE and IMechE/ICE/IET templates only.
Each logo area has the provision for up to
six different partner/sponsor logos each
measuring up to 13.5 x 26mm. Logos can
be inserted/resized/replaced in the same
way as images in section 5 above.

To resize all the logos simultaneously

Once all your artwork is inserted into

the logo placeholders, click each image
independently, hold down the Control
‘Ctrl’ key and ‘'Y’ key simultaneously,

each of the images will resize — this avoids
having to repeat the ‘resize image’ steps.

For more on imagery please see page 24.

11. Map area. There is the provision for the
inclusion of a map measuring 93 x 94.5mm.
The map can be inserted/resized/replaced in
the same way as images in section 5 above.
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John Doe (Ford)
Jane Doe (IMechE)

Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse ut
leo sit amet erat tincidunt posuere. Duis luctus
lacus in enim auctor euismod. Etiam rutrum
libero sed neque. Morbi gravida ante

17 September at 7.30pm

Institution of Mechanical Engineers
1 Birdcage Walk, Westminster
London SW1H 9]]



FORMULA
STUDENT
IN POLE
POSITION.

Subtitle bibendum enim vel sem. Sed
eros. Proin aliquet. Nam sit amet
mauris. Don ec at ligula. Nam euismod.

Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse

ut leo sit amet erat tincidunt posuere. Duis
luctus lacus in enim auctor euismod. Etiam
rutrum libero sed neque. Morbi gravida ante
non est. Cras sit amet erat. Sed blandit, augue
sed luctus volutpat, purus justo volutpat

velit, egestas adipiscing leo leo at diam. In
lacinia imperdiet neque. In hac habitasse
platea dictumst. Sed semper vehi cula elit.
Suspendisse potenti. Aenean inter dum. Mauris
vel magna a nisl ultricies cursus. Ves tibulum
ante ipsum primis in faucibus orci luctus et

HORSE GUARDS ROAD
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Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse

ut leo sit amet erat tincidunt posuere. Duis
luctus lacus in enim auctor euismod. Etiam
rutrum libero sed neque. Morbi gravida ante
non est. Cras sit amet erat. Sed blandit, augue
sed luctus volutpat, purus justo volutpat

velit, egestas adipiscing leo leo at diam. In
lacinia imperdiet neque. In hac habitasse
platea dictumst. Sed semper vehi cula elit.
Suspendisse potenti. Aenean inter dum. Mauris
vel magna a nisl ultricies cursus. Ves tibulum
ante ipsum primis in faucibus orci 400 WORDS

Nunc bibendum enim vel sem. Sed eros. Proin
aliquet. Nam sit amet mauris. Donec at ligula.
Nam euismod. Proin at odio. Suspendisse ut
leo sit amet erat tincidunt posuere. Duis luctus
lacus in enim auctor euismod. Etiam rutrum
libero sed neque. Morbi gravida ante

17 September at 7.30pm

Institution of Mechanical Engineers
1 Birdcage Walk, Westminster
London SW1H 9]]

For more information please contact:

John Doe

+44 (0)20 1234 5678
johndoe@imeche.org
imeche.org/events/automobile/fs



A6 PROGRAMME
OF EVENTS

The A6 Programme of Events template
allows the user to create a multi-page
PDF document for print reproduction

The template contains the following page layouts:

. Front cover

. Contents page

. Introduction

. Events & Activities
. Contacts

. Ad artwork page

. Back page

NO O WwN =

U

Front cover. The front cover design is standard
across all Programme of Events. Please

enter your region or area details in the top

left area. Formatting for this can be found

in the Formatting palette under Region.

2. Contents page. The contents page has
three distinct areas of information.

i. Table of contents. Please list the programme
contents by geographical area if possible.
Formatting for this can be found in the

Formatting palette under Contacts Table Text.

ii. Additional information. There is the provision
for additional information beneath the table of
contents, should this be required. Formatting
for this can be found in the Formatting
palette under Contacts Table Text.

iii. Logo area. Each logo area has the
provision for up to six different partner/
sponsor logos each measuring up to 13.5
x 26.5mm. Logos can be inserted/resized/
replaced in the same way as images.

To resize all the logos simultaneously

Once all your artwork is inserted into

the logo placeholders, click each image
independently, hold down the Control
‘Ctrl’ key and 'Y’ key simultaneously,

each of the images will resize — this avoids
having to repeat the ‘resize image’ steps.

3. Introduction. This area is for your introduction
to this years programme of events. You may
also wish to include some background on
the Institution and it's vision. You should
also include your name, contact details and
a URL where an online version of the guide
is available for download. Formatting for
this can be found in the Formatting palette
under Details/Body Copy/End Intro.

4. Events & Activities. This is the main body of
the Programme of Events where you should list
the events in chronological order. Each event
is assigned its own row within the table and
contains all the pertinent event information.

The tables themselves are created using a bespoke

toolbar which sits on Words native toolbar and
allows users to style and format content.

5 | Table Tools = | Formatting ~ | Update Table of Conterts !

Events tables and rows can be inserted and
deleted using the Events Table menu within

table tools. Each element within the table can be
formatted from either the Formatting palette or by
using the Formatting menu in the bespoke toolbar.

5 ||Table Tools = || Formatting = | Update Table of Contents
i Fle | Ewents Table 3 | Insert Table
El Contacts Table 4 Insert Row
Insert Advertisement Page Delete Row

5 | Table Tools = | |Formatting = || Update Table of Contents !

Fronk Page | 2

Introduction Page »

Events Table »
Contacks Table  »

Heading 1
Heading 2

Biody Text

Please note ‘Heading 1’ inserts a new
blank page, this heading level is picked
up within the table of contents.

5. Contacts. This is used to list all the relevant
region/area contacts. Like the Events tables,
rows can be inserted and deleted using the
Contacts Table menu within table tools. Each
element within the table can be formatted
from either the Formatting palette or by using
the Formatting menu in the bespoke toolbar.

Tahle Tools = || Formatting = | Updats

L

e Events Table |

Zaontacks Table |




Updating the table of contents

To update the table of contents please
click the button featured here:

| Update Table of Contents !

Alternatively, upon printing the document,
the following dialogue box appears, select
‘Update entire table’ and Click ‘OK’:

Update Table of Contents

X]

word is updating the table of contents, Select one
of the Following options:

() Update page numbers anly
(*)ilJpdate entire tablei

Ok ][ Cancel ]

6. Ad artwork page. This page allows you
to place supplied ad artwork into the
layout. Additional ad artwork pages can
be inserted and deleted using the Insert
Advertisments Page menu within table tools.

Please note you cannot insert a new advertisment
page while you have the cursor within a table.

! 1z |[Table Tools ~ || Formatting = | Update Table of Contents !

: File Events Table ¥ |s  Table ‘Windoy

El Contacts Table E E S
.J Insert Advertisement Page |I '

7. Back page. This is the back cover to the

programme. It should remain blank/unbranded.

Pagination

Documents for print reproduction should be
paginated in multiples of 4 pages. Please
insert blank pages into the document should
your document not fit this criteria. Please
liaise with your print supplier should you
require further help with pagination.

Creating print-ready PDF's

In order to create print-ready PDF's from
your Programme of Events layout you
will require Adobe PDF writer.

1. Click ‘File’ > ‘Print’
2. Select ‘Adobe PDF'’ from the drop-down menu
3. Click ‘Properties’

Print |2|rz|

Printer
Mame: | ‘1‘? Adobe POF . ‘ Properties
Status: Idle __Fing Prinker...
Type: Adabe PDF Converter
where! Iy Documents [ Print to File
Comment: [[] Manual duplex
Page range Copies
@ al Mumber of copies:
O Current Dage
() Pages: Collate
Enter page numbers andp’ur page ranges
separated by commas, For example, 1,3,5-12
Prink what: |DDcument - | Zoom
Print: |A\I pages in range g | BRI Bede

Scale to paper size: |Mo Scaling -

4. Click ‘Edit’ from the dropdown menu next to
‘Default Settings’

&Y Adobe PDF Document Properties

Layout | Paper/Quality ‘ [ Adobe PDF Settings
Adobe PDF Conversion Settings

Use these settings to create Adobe PDF documents for quality printing on desktop printers
Q and proofers. Created PDF documents can be opened with Acrobat and Adobe Reader 5.0
atd later

j Edit..
Adobe PDF Output Faolder |F'rompt for Adobe PDF filename j Browse
Adobe PDF Page Siz-: [ -] Ad:.

v iew Adobe PDF results

W Add document infarmation

Default S ettings: | High Quality Print

Adobe PDF Security: | MNone

[v Rely on system fonts only; do not use document fonts
¥ Delete Ing files for successtul jobs

™ Ask to replace sxisting PDF file




5. Revise the ‘Default Page Size’
height and width: W: 105mm H: 148mm
6. Click ‘OK’

High Dusalidy Frini - Adobe POF Setiings

I o Gy o [
) Gereesl J (.
= Images -
Forte
j E::lnf sitwy: b cratn Scobe FOF docurments for gualty prining on ded op
Carabed] FOF chaeuments con b opened vaih Serobal and
) dvarcad eader 5.0 and lsier
(£ Starcdands
Compatbdy. [scrchst 50 FOF 1.4) |
Elbwncd Larwosd Comvgmsecianars | T 85 oy =
Suscrfiotate Fages | Codestrai by Fie -
Rinding [Lan =
Fschation: [2000 ki péi inch
W Al Fages
T Pagas Fiom Ta
I~ Embed thumbeast:
' Digtirvizn Fox Fast vres vides
Ol Pags 508
Wik |105 Lindks
T S il 5ttt Hieight: |14
Save s 0K I Corcel Help

7. Save and name the setting
ie ‘A6_ImechE Print Option’

Save Adobe PO Settings As

Save i |._i‘-:rllr-:s j - & I':F E'
5 I 5 mbogeiore
LJ ¥ tviechE i best inhogkiors
My Frecent I rovsmala fact sttt jrboptions
Dasisinirds
Deshtop
My Droeaamerits
M Companer
MyHotwork T name: [65 IMechE Pri Optize =] [ sae
Flacet r
Gaé gt et [fusobe FOF Setbngs Fles [ pboplorns] | Coreel |

9. Add ‘Paper Size' measurements:
W: 10bmm H:148mm

10. Type description of setting in ‘Paper Name’
ie ‘IMechE A6’
11. Click ‘Add/Modify’

Add Custom Paper Size

IMechE A

FPaper Mames:

Paper Size Urit
Wwidth  |148.0 " Inch
" Millimeter
Height |105.0 © Point

AddyModify |

Cancel | Delete

12. After clicking ‘Add/Modify’ the following
dialogue appears (see below)

13. Select ‘A6_IMechE Print Option’ from the
‘Default Settings’ dropdown menu

14. Select ‘IMechE_AG6’ from the ‘Adobe
PDF Page Size’ dropdown menu

15. Click ‘OK’ to print to PDF

%" Adobe PDF Document Properties

Layout | Paper/Quality [’E Adobe PDF Settings

Adobe PDF Conversion Settings

Use these settings to create Adobe PDF documents for quality printing on desktop printers
Q and proofers. Created PDF documents can be opened with Acrobat and &dobe Reader 5.0
and later.

Default Settings: |AE_IMechE Frint Option j Edit.
Adobe POF Output Folder |P|ompt for Adobe POF filename j Erowse...

Adabe POF Page Size: [ Add

Adobe PDF Security: | Mone

¥ Wiew Adobe POF results

v dd document information
[V Rely on system fonts only: do pot use document fonts
[¥ Delete log files for successful johs

[~ Ask to replace existing PDF file

Please liaise with your print supplier
should you require further help with
production of your print-ready PDF.

It is your responsibility to obtain and approve
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Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent sed
sapien. Nulla neque diam, ornare in, mattis vitae, viverra sit amet,
enim. Vestibulum ut dolor sit amet pede lobortis sodales. Vivamus
dictum commodo dolor. Vivamus vel magna. Integer elementum
ornare justo. Donec fermentum, metus non facilisis imperdiet, urna
libero vehicula nisl, id vehicula enim nisi quis mauris. Nullam metus
felis, fermentum non, pretium eget, scelerisque et, metus. Vivamus
fermentum leo nec velit. Phasellus posuere nunc facilisis justo. Sed
tellus quam, facilisis eu, laoreet ac, tincidunt nec, risus.
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Contacts

LANCASHIRE COMMITTEE

Chair John Doe +44 (0)1234 5678 9123
john.doe@imeche.com

Secretary John Doe +44 (0)1234 5678 9123
john.doe@imeche.com

Treasurer John Doe +44 (0)1234 5678 9123
john.doe@imeche.com

Publicity John Doe +44 (0)1234 5678 9123
john.doe@imeche.com

NORTH WEST YOUNG MEMBERS PANEL

Chair John Doe +44 (0)1234 5678 9123
john.doe@imeche.com
Vice-Chair John Doe john.doe@imeche.com
Secretary John Doe john.doe@imeche.com
Treasurer John Doe john.doe@imeche.com
Asst Secretary John Doe john.doe@imeche.com
Asst Treasurer  John Doe john.doe@imeche.com
Publicity & Web John Doe +44 (0)1234 5678 9123

john.doe@imeche.com

YM Rep John Doe john.doe@imeche.com




Introduction

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent sed
sapien. Nulla neque diam, ornare in, mattis vitae, viverra sit amet,
enim. Vestibulum ut dolor sit amet pede lobortis sodales. Vivamus
dictum commodo dolor. Vivamus vel magna. Integer elementum
ornare justo. Donec fermentum, metus non facilisis imperdiet, urna
libero vehicula nisl, id vehicula enim nisi quis mauris. Nullam metus
felis, fermentum non, pretium eget, scelerisque et, metus. Vivamus
fermentum leo nec velit. Phasellus posuere nunc facilisis justo. Sed
tellus quam, facilisis eu, laoreet ac, tincidunt nec, risus.

Nam hendrerit mollis lectus. Pellentesque metus odio, consequat ut,
pulvinar ultrices, aliquet sit amet, massa. Nullam semper. Aliquam
pretium mollis tellus. Etiam ipsum quam, blandit ut, hendrerit nec,
tincidunt a, quam. Donec molestie mollis nulla. Nulla vitae tellus ut diam
tempor auctor. Suspendisse potenti. Praesent purus arcu, sodales vel,
scelerisque nec, dignissim ac, magna. Praesent molestie mollis magna.
Nulla facilisi. Donec tempus nibh et enim. Donec est risus, pharetra

a, dignissim at, dictum id, lacus. Sed venenatis commodo lacus.
Vestibulum lectus nibh, pellentesque vel, iaculis sed, ornare sed, nibh.
Mauris ultrices mi at dui. Duis nunc lacus, blandit vitae, imperdiet vitae,
semper ut, arcu. Nam libero orci, ultricies et, imperdiet at, scelerisque
tristique.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Praesent sed
sapien. Nulla neque diam, ornare in, mattis vitae, viverra sit amet,
enim. Vestibulum ut dolor sit amet pede lobortis sodales. Vivamus
dictum commodo dolor. Vivamus vel magna. Integer elementum
ornare justo. Donec fermentum, metus non facilisis imperdiet, urna
libero vehicula nisl, id vehicula enim nisi quis mauris. Nullam metus
felis, fermentum non, pretium eget, scelerisque et, metus. Vivamus
fermentum leo nec velit. Phasellus posuere nunc facilisis justo. Sed
tellus quam, facilisis eu, laoreet ac, tincidunt nec, risus.

John Doe

Chairman North West Region
+44 (0)1234 567891
johndoe@imeche.org

This programme of events is also available as a download from:
www.imechewestcumbria.org.uk
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Cheshire

Events & Activities

http://nearyou.imeche.org.uk/uk/nwes/RUAMAN
For area contact information, please see the contact section

Monday THE ROLE OF RISK ASSESSMENT IN THE Process
19 January SELF REGULATION OF PROCESS PLANTS Industries
7pm-9pm Speaker: John Hudson Division
BAE Systems Submarine Solutions
Refreshments Location: The Academy, Bentley Motors,
6.30pm Pyms Lane, Crewe CW1 3PL
Contact: Paul Jones 01270 656557
Keith Holmes 01204 528851
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Monday THE ROLE OF RISK ASSESSMENT IN THE Process
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BAE Systems Submarine Solutions
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6.30pm Pyms Lane, Crewe CW1 3PL
Contact: Paul Jones 01270 656557
Keith Holmes 01204 528851
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6.30pm Pyms Lane, Crewe CW1 3PL
Contact: Paul Jones 01270 656557
Keith Holmes 01204 528851
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A4 NEWSLETTER
TEMPLATE

The A4 regional newsletter template is either
one or two-sided depending on the amount of
content, and features space for up to 8 articles,
a Diary of Events and a Contact Us section.

1. Newsletter title and date. This should take
the form of Region name, Area or YMP
name, Newsletter, followed by the month
or quarter. Each element should be set in
title case. Area/Region/YMP/Date details
should be set in Dark Red and Newsletter
in Red. Formatting for this element can
be found in the Formatting palette.

2. Article Headlines. The headlines throughout
the document are set in Verdana Bold
in title case in Dark Red. This is also
applicable to the Introduction, Diary of
Events and Contact Us section headers.
Formatting for each of these elements can
be found in the Formatting palette.

Article body copy. Article body copy
throughout the document is set in Verdana
in black. Formatting for this element can
be found in the Formatting palette.

3. Word Counts. Below is a guide to word
counts for each of the articles.

Side 1

Introduction 125 words
Articles 1-2 150 words
Article 3 100 words

Side 2
Articles 4-6 125 words
Articles 7-8 175 words

4. Image Sizes. Below is a guide to image
sizes for each of the articles.

Side 1
Articles 1-2 62 x 49mm

Side 2
Articles 4-6 62 x 39mm
Articles 7-8 62 x 57mm

To insert an image

i. Double click the prompt within the placeholder,
for example: “Dbl click to insert image.

ii. Locate the image

iii. Click ‘Insert’

To resize the image

i. After inserting the image, single click it, then
drag from the bottom right anchor until the
image is the desired size within the placeholder.

To replace the image

i. Click ‘Insert’

ii. Click ‘Picture’

iii. Click ‘From File' and navigate to the file

location, insert the new image and resize

For more on imagery please see page 24.
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INTRODUCTION

Mauris felis nisi, vulputate a ultricies vel, lobortis sed ipsum.

Pellentesque luctus scelerisque est porta consectetur. Praesent
mollis libero vitae urna ullamcorper mollis. Phasellus id nibh
laoreet sapien ullamcorper euismod a id tellus. Ut et augue
vestibulum risus faucibus dapibus. Aenean molestie cursus
lacinia. Donec eget sem quam. Aliguam mattis ullamcorper
lorem sed mollis. Donec molestie lobortis augue, vitae iaculis
lacus gravida elementum. In ut ipsum nisl. Vivamus ac ipsum
sem. Fusce dignissim pellentesque risus eu laoreet. Quisque quis
sem et nibh tempor fermentum ac non nunc. Nullam accumsan
sagittis risus, quis consequat massa fringilla ac. Donec at justo
sapien. Nullam vestibulum nisi a dui dapibus faucibus. Morbi
consectetur nisi sit amet purus aliquet placerat. (125 words)

FORMULA STUDENT 2010
— A LOCAL HERO IS BORN

At, semper eu elit. Pellentesque vitae
elementum arcu. Ut massa sapien,
convallis nec faucibus in, dictum vel
ipsum. Phasellus a sem vitae libero
pharetra ultrices. Mauris posuere ultricies
condimentum. Nunc varius euismod
ipsum, sed porta neque porttitor non.
Suspendisse quis enim dolor, sit amet
accumsan eros. Sed ut ipsum nec purus
ornare scelerisque vel nec est. Nunc justo
diam, gravida in commodo ut, lacinia non

amet feugiat nulla posuere eget

Ornare scelerisque vel nec est. Nunc justo
diam, gravida in com modo ut, lacinia

non Pellentesque congue posuere rutrum.
Mauris vel euismod nisl. Donec luctus
tellus sit amet sem rutrum ac malesuada
neque lacinia. Donec vel ligula et enim
lacinia pulvinar ac quis eros. Integer
sapien mauris, sodales eget vulputate in,
porta gravida tortor. Nullam iaculis nibh

a ligula pellentesque faucibus at sit amet
mauris. Vestibulum ac interdum magna.
Pellentesque elementum dolor lacus. Nam
eu turpis eros, erat. (150 words)

RENEWABLE ENERGY
AND CLIMATE CHANGE

At, semper eu elit. Pellentesque vitae
elementum arcu. Ut massa sapien,
convallis nec faucibus in, dictum vel
ipsum. Phasellus a sem vitae libero
pharetra ultrices. Mauris posuere ultricies
condimentum. Nunc varius euismod
ipsum, sed porta neque porttitor non.
Suspendisse quis enim dolor, sit amet
accumsan eros. Sed ut ipsum nec purus
ornare scelerisque vel nec est. Nunc justo
diam, gravida in commodo ut, lacinia non

amet feugiat nulla posuere eget

Ornare scelerisque vel nec est. Nunc justo
diam, gravida in com modo ut, lacinia

non Pellentesque congue posuere rutrum.
Mauris vel euismod nisl. Donec luctus
tellus sit amet sem rutrum ac malesuada
neque lacinia. Donec vel ligula et enim
lacinia pulvinar ac quis eros. Integer
sapien mauris, sodales eget vulputate in,
porta gravida tortor. Nullam iaculis nibh

a ligula pellentesque faucibus at sit amet
mauris. Vestibulum ac interdum magna.
Pellentesque elementum dolor lacus. Nam
eu turpis eros, erat. (150 words)

5™ ARNOLD BARKS MEMORIAL
CHRISTMAS LECTURE 2010

Nunc sodales ullamcorper blandit. Integer
ac velit ut neque semper aliquet. Mauris
nec nulla eget magna dignissim tempor.
Integer a sem ligula, at adipiscing

urna. Etiam a metus sed massa ornare
venenatis. Nulla consequat cursus est at
facilisis. Cum sociis natoque penatibus et
magnis dis parturient montes, nascetur
ridiculus mus. Donec lobortis ultricies
imperdiet. Donec at ultricies justo. Cras
ac nunc quis leo dictum hendrerit. In hac
habitasse platea dictumst.Donec laoreet
dignissim laoreet. Praesent malesuada
velit eget metus congue porttitor feugiat
orci euismod. Ut a libero sit amet velit
porttitor venenatis eu a lacus. Nulla
sodales erat molestie (100 words)

DIARY OF EVENTS

Event title #1 Date #1
Location details

Event title #1 Date #1
Location details

Event title #1 Date #1
Location details

Event title #1 Date #1
Location details

Event title #1 Date #1
Location details

Event title #1 Date #1
Location details

CONTACT US

Duis lobortis aliquet neque et faucibus.
Aliguam in enim tortor. Nulla tristique,
tellus et iaculis tristique, nibh mi viverra
nibh, et pulvinar nunc odio at dolor.
Curabitur et lectus nisi. Ut aliquet eros
nec magna tempor sed porta odio.

Contact Name
Contanct Phone
Contact Email
Contact URL

Improving the world through engineering
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PRIVACY WARS: IS BIG
BROTHER WATCHING YOU?

Duis lobortis aliquet neque et faucibus.
Aliquam in enim tortor. Nulla tristique,
tellus et iaculis tristique, nibh mi viverra
nibh, et pulvinar nunc odio at dolor.
Curabitur et lectus nisi. Ut aliquet eros
nec magna tempor sed porta odio
molestie. Morbi et nisi quis justo vulput
vestibulum et at turpis. Etiam sed elit
vel sem mattis posuere ac non nunc.
Pellentesque quis fermentum ligula. Cras
nunc magna, blandit vel gravida sit amet,
aliquet et eros. Suspendisse ullamcorper
ante ac mauris fermentum in adipiscing
risus fringilla. Donec adipiscing mauris
aliquet et eros. Suspendisse ullamcorper
ante ac mauris ferm entum in adipiscing
risus fringilla. Donec adipiscing mauris
Curabitur et lectus nisi. Ut aliquet eros
erat, sodales tincidunt nisl. Etiam ut lor
turpis, ut feugiat ligula. (125 words)

OUR LOW-CARBON POLICY:
IS IT ACHIEVABLE?

Duis lobortis aliquet neque et faucibus.
Aliguam in enim tortor. Nulla tristique,
tellus et iaculis tristique, nibh mi viverra
nibh, et pulvinar nunc odio at dolor.
Curabitur et lectus nisi. Ut aliquet eros
nec magna tempor sed porta odio
molestie. Morbi et nisi quis justo vulput
vestibulum et at turpis. Etiam sed elit
vel sem mattis posuere ac non nunc.
Pellentesque quis fermentum ligula. Cras
nunc magna, blandit vel gravida sit amet,
aliquet et eros. Suspendisse ullamcorper
ante ac mauris fermentum in adipiscing
risus fringilla. Donec adipiscing mauris
aliquet et eros. Suspendisse ullamcorper
ante ac mauris ferm entum in adipiscing
risus fringilla. Donec adipiscing mauris
Curabitur et lectus nisi. Ut aliquet eros
erat, sodales tincidunt nisl. Etiam ut lor
turpis, ut feugiat ligula. (125 words)

UK AEROSPACE
MANUFACTURING

Duis lobortis aliquet neque et faucibus.
Aliqguam in enim tortor. Nulla tristique,
tellus et iaculis tristique, nibh mi viverra
nibh, et pulvinar nunc odio at dolor.
Curabitur et lectus nisi. Ut aliquet eros
nec magna tempor sed porta odio
molestie. Morbi et nisi quis justo vulput
vestibulum et at turpis. Etiam sed elit

vel sem mattis posuere ac non nunc.
Pellentesque quis ferm entum ligula. Cras
nunc magna, blandit vel gravida sit amet,
aliquet et eros. Suspendisse ullamcorper
ante ac mauris fermentum in adipiscing
risus fringilla. Donec adipiscing mauris
aliquet et eros. Suspendisse ullamcorper
ante ac mauris fermentum in adipiscing
risus fringilla. Donec adipiscing mauris
Curabitur et lectus nisi. Ut aliquet eros
erat, sodales tincidunt nisl. Etiam ut lor
turpis, ut feugiat ligula. (125 words)

TRAINING & PROFESSIONAL
DEVELOPMENT

At, semper eu elit. Pellentesque vitae
elementum arcu. Ut massa sapien,
convallis nec faucibus in, dictum vel
ipsum. Phasellus a sem vitae libero
pharetra ultrices. Mauris posuere ultricies
condimentum. Nunc varius euismod
ipsum, sed porta neque porttitor non.
Suspendisse quis enim dolor, sit amet
accumsan eros. Sed ut ipsum nec purus
ornare scelerisque vel nec est. Nunc justo
diam, gravida in commodo ut, lacinia non
dolor. Donec volutpat ullamcorper nisl, sit
amet feugiat nulla posuere eget

Ornare scelerisque vel nec est. Nunc justo
diam, gravida in commodo ut, lacinia non
Pellentesque congue posuere rutrum.
Mauris vel euismod nisl. Donec luctus
tellus sit amet sem rutrum ac malesuada
neque lacinia. Donec vel ligula et enim
lacinia pulvinar ac quis eros. Integer
sapien mauris, sodales eget vulputate in,
porta gravida tortor. Nullam iaculis nibh

a ligula pellentesque faucibus at sit amet
mauris. Vestibulum ac interdum magna.
Nullam vel ligula non mi imperdiet ornare.
Pellentesque elementum dolor lacus. Nam
eu turpis eros, a tincidunt erat. Quisque
sit amet nisi magna, sit amet semper sem.
consequat pullamcorper. (175 words)

INSPIRING THE NEXT
GENERATION LECTURE

At, semper eu elit. Pellentesque vitae
elementum arcu. Ut massa sapien,
convallis nec faucibus in, dictum vel
ipsum. Phasellus a sem vitae libero
pharetra ultrices. Mauris posuere ultricies
condimentum. Nunc varius euismod
ipsum, sed porta neque porttitor non.
Suspendisse quis enim dolor, sit amet
accumsan eros. Sed ut ipsum nec purus
ornare scelerisque vel nec est. Nunc justo
diam, gravida in commodo ut, lacinia non
dolor. Donec volutpat ullamcorper nisl, sit
amet feugiat nulla posuere eget

Ornare scelerisque vel nec est. Nunc justo
diam, gravida in commodo ut, lacinia non
Pellentesque congue posuere rutrum.
Mauris vel euismod nisl. Donec luctus
tellus sit amet sem rutrum ac malesuada
neque lacinia. Donec vel ligula et enim
lacinia pulvinar ac quis eros. Integer
sapien mauris, sodales eget vulputate in,
porta gravida tortor. Nullam iaculis nibh

a ligula pellentesque faucibus at sit amet
mauris. Vestibulum ac interdum magna.
Nullam vel ligula non mi imperdiet ornare.
Pellentesque elementum dolor lacus. Nam
eu turpis eros, a tincidunt erat. Quisque
sit amet nisi magna, sit amet semper sem.
consequat pullamcorper. (175 words)




CREATING

LOW-RESOLUTION PDF'S

Low-resolution PDF’s should be created when
you wish to circulate the document via email.

In order to create low-resolution PDF’s from your
layout you will require Adobe PDF writer.

1. Click ‘File’ > ‘Print’

2. Select ‘Adobe PDF’ from the drop-down menu
3. Click ‘Properties’

Printer

Select ‘72dpi’ from the ‘Graphic
Print Quality’ drop down

Click ‘OK’

Click the ‘Adobe PDF Settings’ tab
and click OK to create a PDF

Adobe PDF Converter Advanced Options

ﬁs Adobe PDF Converter Advanced Docurment Settings
= Eg Paperioutput

Paper Size: [MechE A&

Copy Count: 1 Copy

4. Select your default settings e.g. A4 or A6
5. Click ‘Layout’
6. Click ‘Advanced’

%% Adobe PDF Document Properties

Layout ‘ Paper/Guality || w Adobe PDF Settimgs|

Orientation

@ Partrait

(O Landscape

() Rotated Landscape

Pages Per Sheet:

Mame: q‘g Adobe POF v‘ Properties = @ Graphic
Status: Idle _ Print Quality: | 72dpi

Find Printer. ..
Type: Adaobe PDF Conwverter =] @ Image Color M4 m
Where: My Documents [ Print to File
Camment: [] Manual duplex 1M Metha @ 144dpi
Page range Copies ICM Inkent 300dpi
[CF-1] humber of copies: F: Sealing: 100 % £00dpi
gcurrgﬂt e : TrueType Fonk 1200dpi Evice Font

[ Coate = ih Document Options 2400dpi
Enter page numbers andfor page ranges ) 5
separated by commas. For example, 1,3,5-12 ﬁg FastScripk Op 3600dpi

4000dpi
Print what: |Dacument v| Zoom p
Print: |A\I pages in range v | Sl L page he
OK Cancel
[ ok ] [ Cancel




IMAGERY

Please see section 4.10 of the IMechE brand
guidelines for a more extensive overview of
imagery. The guidelines are available for download
from http://www.imeche.org/brandidentity

Advanced Image Manipulation

Ideally images should be cropped and
sized to the correct dimensions prior to
being imported into Microsoft Word.

Irfanview is a powerful, yet simple to use
freeware application which can be used to
manipulate imagery prior to its importation.

http://www.irfanview.com/
Image resolution

Images used in the templates which are for
print reproduction should be at size at 300dpi.

Images used in the templates which are for
screen reproduction should be at size at 72dpi.

To determine an images resolution PC

users can right click any image file, select
‘Properties’, select ‘Summary’ and finally
select ‘Advanced’ this dialogue box displays
the image dpi/resolution information.

Copyright

Please ensure you have permission to use any
imagery you include within your layout. It is your
responsibility to ensure that you are not in breach
of any copyright or intellectual property laws.

Royalty-free images

A good source of reasonably priced, royalty-
free imagery is istockphoto or Dreamstime.

http://www.istockphoto.com
http://www.dreamstime.com/



CONTACT

Regional & International Operations
T +44(0)20 7973 1247

E regions@imeche.org
international@imeche.org
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